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Identify Product/Service: Clothing Rental Subscription Service from TrendyMart: “RentyMart”
STP Analysis:
Audience 1: Fashion-Conscious College Students

e Segment: This group is composed of college students (18-22) who are active members of
their campus community and want to be aligned with the latest fashion trends as they are
perceived by their peers on a daily basis. That said, they do not have the time or monetary
resources to shop for the latest fashion drops monthly.

e Targeting: Young people pursuing collegiate degrees are often influenced by their peers,
and fashion is a key indicator of personal identity and in-group association. This
influence has only increased in recent years with the popularization of digital fashion
trends on Tiktok and Instagram (among other social media platforms) that have
encouraged college students to share their outfit of the day and communicate their
clothing choices to wider audiences. Examples of students to target include sorority and
fraternity members, clubs/special interest group members, and athletes who all have their
own style guides that our clothing service can accentuate.

e Positioning: For college students looking for the latest fashion trends on a budget, our
clothing service is the perfect subscription to enhance your personal style and stand out
confidently amongst your peers.

Audience 2: Young Urban Professionals



e Segment: This group consists of young adults (22-26) starting their full-time professional

careers post-graduation who generally reside in urban areas with colleagues also largely
in their twenties.

Targeting: The professional-meets-city living fusion of these bustling urban environments
fosters the ideal atmosphere for our brand to succeed, as young adults are seeking fashion
that is both business casual and in-style enough to start a conversation with colleagues at
work or going out. This segment is looking to be taken seriously in a work environment
but also knows how to have a good time out in the city, and they want their clothing to be
a reflection of that, but for an affordable price point that is obtainable at an introductory
salary.

Positioning: For young adults residing in business hotspots like Chicago, Los Angeles,
and New York aiming to elevate their workplace and nightlife style, look no further than
our trendy clothing service that will put you at the center of personal and professional
conversation. Our service ships you the latest business casual and bar outfits monthly to
ensure you have the most up-to-date accessories available without the stress and time of

shopping yourself.

Audience 3: Busy Caretakers/Guardians

Segment: This group consists of middle-aged guardians (30-40) who are raising a child
for the first time and are busy balancing their new lifestyle of work and care.
Targeting: These individuals have always been style-oriented while living and working
on their own, but are now faced with a fashion dilemma as they do not have the time or
energy to consistently shop for themselves while also shopping and caring for their

child(ren). As they adjust to a guardian role and have to prioritize the interests of their



child(ren), their personal style identity diminishes. Our clothing subscription service
alleviates this concern by planning and shipping a personalized style guide to guardians
so they can focus more time on their kids.

e Positioning: For busy caretakers with a keen eye for fashion but a lack of time and energy
for personal shopping, our clothing subscription service is the perfect remedy for your
style stresses. Our service mails your favorite looks to you monthly and automatically, so

you can be confident you’re looking your best while dedicating time to your kids.

Research Objectives:

Overall objective: By May 15, 2024, determine whether people who shop at TrendyMart are

interested in a clothing rental service.

Specific objectives:

Target Audience 1: Fashion-Conscious College Students (18-22)

Objective 1.1: Determine whether fashion-conscious college students believe that
TrendyMart’s clothing is fashionable.

Sub-Objective 1.1.2: Discover the current perceptions of TrendyMart among college students
(18-22) in these cities.

Sub-Objective 1.1.3: Determine whether college students consider TrendyMart clothing stylish

and in line with current fashion trends.

Objective 1.2: Determine what college students are willing to pay for this product.
Sub-Objective 1.2.1: What is the maximum amount college students (18-22) are willing to pay

per month for a clothing rental subscription?



Sub-Objective 1.2.2: Are there any features (e.g., unlimited exchanges, designer brands) that

would justify a higher subscription price?

Target Audience 2: Young Urban Professionals (22-26

Objective 2.1: Determine whether TrendyMart satisfies young urban professionals’ fashion
needs.

Sub-Objective 2.1.1: Does the clothing you could rent from TrendyMart match the work and
nightlife styles that these Young Urban Professionals are likely to buy?

Sub-Objective 2.1.2: What are the biggest challenges young urban professionals face when
trying to maintain a professional yet trendy wardrobe on a limited budget?

Objective 2.2: Find whether young urban professionals are interested in a clothing rental
service to suit their clothing needs.

Sub-Objective 2.2.1: How interested are Young Urban Professionals (22-26) who live in
Chicago, Los Angeles, and New York in a clothing rental service that offers both business casual
and trendy attire?

Sub-Objective 2.2.2: What key features (e.g., variety of styles, dry cleaning included) would

make a clothing rental service most appealing to this demographic?

Target Audience 3: Busy Caretakers/Guardians (30-40

Objective 3.1: Determine whether busy caretakers/guardians perceive that they have
trouble buying new clothes and maintaining their personal style, and if so, why.
Sub-Objective 3.1.1: How often do busy caretakers/guardians (30-40) feel they have time to shop

for new clothes for themselves?



Sub-Objective 3.1.2: What are the biggest barriers that prevent busy caretakers/guardians from
maintaining their personal style?

Objective 3.2: Find out whether busy caretakers/guardians are interested in a service that
will aid them in style curation.

Sub-Objective 3.2.1: Would busy caretakers/guardians (30-40) be interested in a clothing rental
service that offers pre-curated style guides based on their preferences?

Sub-Objective 3.2.2: What types of clothing styles (e.g., casual, work-from-home, weekend

wear) would be most appealing to this demographic in a pre-curated rental plan?

Research Design:
Three different techniques will be used to gather relevant information about our target audiences.
1. Survey methodology | Target audience: Fashion-conscious college students (18-22)
To gather data about this group, an online survey will be distributed via social media platforms,
specifically on TikTok and Instagram, which are more frequented platforms by this demographic
of 18 to 22-year-olds. Online surveys are a cost-effective and easy way to reach a large sample
size of college students, providing clear questions to the demographic that will show relevant
data about whether this group would be interested in the rental services, as trends online
frequently change. An incentive for filling out such feedback could be the chance to receive one
free rental clothing option from their site or some unrelated gift to guarantee higher response
rates. Some limitations include the potential for response bias as only students active on social
media may participate. Additionally, the results provide a limited depth of responses compared to

qualitative methods.



2. Focus Groups | Target Audience: Busy Caretakers/Guardians (30-40), Young urban
professionals (22-26)

To gather data about these groups, organizing focus groups is an effective way of finding out
valuable information, using community centers or online platforms to do so. Focus groups
facilitate group discussions, allowing participants to build upon each other's responses and
provide nuanced insights. Both in-person and online options accommodate participants'
schedules, as both groups are very busy. There would be several regions represented, many of the
groups being based in large metro areas — young professionals will primarily be based in cities
while busy caretakers will be sought after in suburban regions. Some limitations are that group
dynamics may influence individual opinions, however, the goal is to get general information
about our target audiences and further improve the rental brand’s reach to them. Therefore, the
overall consensus of the group is the primary thing we want to obtain. There could also be
limited representation of diverse caretaker demographics in some focus groups. However, our
target audiences may likely have some disposable income to be using this service and therefore,
class representation is not necessary.

3. Content Analysis | Target Audience: All Audiences
We will analyze social media content related to fashion rental services, including posts,
comments, and reviews. Content analysis provides insights into public opinions, preferences, and
sentiments toward clothing rental services. Social media platforms offer a wealth of
user-generated content for analysis, therefore based on the general ages in correlation with the
types of social media use, we would analyze these different demographics. A limitation is in the
lack of control over the content's authenticity and reliability, especially as Al makes content

more difficult to navigate through.



TIPCUP Lede:
Your next wardrobe will never go out of style —TrendyMart’s new clothing rental subscription
service provides access to the latest trends with less commitment and more sustainable shopping.

99 ¢¢

- Timeliness: “next wardrobe” “new clothing rental subscription” “latest trends”
- Impact & Prominence: staying trendy, saving money, good for the environment

- Proximity: immediate change to the TrendyMart consumer experience

- Unique: the idea of your wardrobe never going out of style

Ethical Considerations:

Conducting ethical research is both essential and feasible given our research plan. For
primary research through surveys and focus groups, we will follow standard procedures to
maintain confidentiality. Surveys will not collect any identifying information, but will use
demographic and psychographic data to inform our analysis. Participating in a focus group is
voluntary, meaning there is no coercion to be involved with the research. Focus group
environments are often dependent on the manner in which the session is led, so our researchers
will be sure to create a professional yet welcoming environment in which consumers can freely
share their insights. Finally, secondary research will be conducted through an analysis of social

media content, which will also not include any identifying information.

Data Analysis Plan:

In-Depth Interviews:

Affinity Mapping



Gathering Information: Begin by gathering your information via consumer interviews. Use the
notes you jotted down during the interview and compile all key insights.

Sort Through Information: Group similar ideas together based on their content or meaning. A
useful method is to write all insights on sticky notes and group them on a whiteboard or table.
Feel free to move the sticky note insights as you see fit.

Identify Group Themes: Once you have your initial groupings, identify overarching themes that
connect these groups of insights.

Name Each Theme: Label each theme with a clear and concise title that reflects the common
thread among the ideas within it. These themes will serve as your main insights from the

interview

Survey Methodology:

Qualitative Analysis Method

Response coding: Review open-ended survey responses about rental service interest and online
trend awareness. Create a coding system to group responses based on interest levels, trend
awareness, rental motivations, and concerns.

Theme identification: Merge similar codes to identify recurring themes in the data and look for
relationships between interest levels, trend awareness, motivations, and concerns.
Interpretation and reporting: Analyze identified themes and their prevalence. Consider trend
awareness impact on rental service interest, primary reasons for considering rental service,

potential customers' worries and subgroups with distinct themes.



Findings reporting: To present qualitative analysis findings effectively, summarize the identified
themes and their prevalence, illustrate themes with relevant quotes, and discuss the implications

of the findings for the development and marketing of the proposed rental service.

Quantitative Analysis Method
SPSS - variable relationship analysis

e Relationships between 2 Variables: Use a 2x2 ANOVA Between-Subjects

To ensure accurate analysis, format your data with one dependent variable and two or
more independent variables, with each row representing a unique observation or
participant. To access the General Linear Model (GLM) Menu, navigate to "Analyze" ->
"General Linear Model" -> "Univariate." Then, move your dependent variable to the
"Dependent Variable" box and your independent variables to the "Fixed Factors" box. If
you'd like to run additional post-hoc tests, such as Tukey's HSD, select "Post Hoc Tests"
under "Options." Once you've made your selections, click "Paste" to copy the
SPSS-generated syntax into the syntax window. Finally, click "Run" -> "All" to execute
the analysis. In the SPSS output, locate the "Tests of Between-Subjects Effects" table to
review the F-statistic and significance level for each effect. A significant p-value,

typically below 0.05, indicates a statistically significant effect on the dependent variable.

Excel - data visualization

e Trend Visualization: Create a line graph



To create a line graph in Excel, ensure you have two columns of data—one for the X-axis
and another for the Y-axis. Then, go to the "Insert" tab, click "Line" in the "Charts"
group, and choose the suitable graph for your research project.

Easy Data Viewing: Pivot Table

To organize data in a table format, select the data range, go to the "Insert" tab, and click
on "PivotTable" in the "Tables" group. Choose where to put the pivot table, and drag and
drop the fields you want to categorize in the "PivotTable Fields" pane. Finally, drag a
numeric field to the "Values" section to calculate summary values. Optionally, customize
the table by using the "PivotTable Analyze" tab to filter your data, calculate additional

statistics, and change the layout.

Content Analysis:

Content Analysis (Coding And Analyzing Data)

1.

2.

Create a coding scheme to classify your content based on your research question.
Assign codes systematically to each piece of content.

Refine your coding scheme as your code to capture the data accurately.

Use software for quantitative analysis if applicable.

Identify themes for qualitative analysis.

Interpret your findings and report on their meaning and context for your research.



